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 2-DAY SHIPPING!*

Buy online and avoid the lines with FREE 2-day shipping 
from the Ubisoft Store. Enter 2DAYFREE at checkout! Spend 
your time playing this game, while we deliver the next one, 
shipped FREE!
*To redeem this coupon, go to http://store.ubi.com and enter Coupon Code 2DAYFREE at checkout. Offer 
expires July 31, 2005. Offer applies to your next purchase at the Ubisoft Store. Products subject to 
availability. May not be combined with any other promotional offers or discounts, applied to previous orders, 
substituted, exchanged, sold, or redeemed for cash or other goods or services. Limit one per customer. 
Offer valid on orders with U.S. shipping destinations only. Offer only available at http://store.ubi.com.
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AVAILABLE NOW
Master History's Greatest Game

Learn to avoid costly mistakes 
with specific advice in Blunder 
Alert mode.

Powerful enough to take your 
game to the Grandmaster level. 

Easy-to-navigate interface with  
a huge variety of 3D sets and 
boards.

Receive personalized instruction  
at the Chessmaster Academy.

Use enclosed glasses for an  
enhanced 3D view.

www.chessmaster.com
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Nintendo
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DS™
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video game 
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Game Boy® 
Advance

PCPSP™ 
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console

Check if you prefer NOT to receive Ubisoft newsletters or special offers.
Cochez ici si vous ne souhaitez pas recevoir de bulletins de nouvelles électroniques ou d’offres spéciales.
No deseo recibir noticias u ofertas especiales de parte de Ubisoft.
NOTICE: Ubisoft respects the privacy of users. For more information on the Ubisoft Privacy Policy, please visit www.ubi.com.
NB. Ubisoft respecte la vie privée des gens. Pour plus d’informations sur nos politiques, veuillez consulter notre site internet 
www.ubi.com.
NB. Ubisoft respeta la privacidad de sus usuarios. Para más información visite www.ubi.com. 

Register online and enjoy the benefits!
Abonnez-vous en ligne dès maintenant et profitez de nombreux avantages !

¡Regístrese en línea y goce de los beneficios!

• Be in the know – learn in advance 
of new games via email.

• Receive exclusive savings offers.
• Participate in focus groups – 

help create new games.        
• Get access to full technical 

support.

• Soyez le/la premier/ère à 
connaître les nouveaux jeux 
d’Ubisoft par courriel.

• Recevez en exclusivité des offres 
promotionnelles.

• Participez à des forums de 
discussion – aidez nous à créer 
de nouveaux jeux. 

• Accédez à notre service technique.

• Sea el primero en conocer nuestros 
próximos lanzamientos Ubisoft.

• Reciba en exclusiva nuestras 
ofertas.

• Participe en nuestros foros  
de discusión.

• Reciba acceso al soporte técnico.

WARRANTY
Ubisoft warrants to the original purchaser of its products that the products will be free from defects in materials and 
workmanship for a period of ninety (90) days from the date of purchase. Ubisoft products are sold “as is,” without 
any expressed or implied warranties of any kind, and Ubisoft is not liable for any losses or damages of any kind 
resulting from use of its products. Ubisoft agrees for a period of ninety (90) days to either replace defective product 
free of charge provided you return the defective item with dated proof of purchase to the store from which the 
product was originally purchased or repair or replace the defective product at its option free of charge, when 
accompanied with a proof of purchase and sent to our offices postage prepaid. This warranty is not applicable to 
normal wear and tear, and shall be void if the defect in the product is found to be as a result of abuse, 
unreasonable use, mistreatment, or neglect of the product.
Limitations: This warranty is in lieu of all other warranties and no other representations or claims of any nature 
shall be binding on, or obligate Ubisoft. Any implied warranties applicable to Ubisoft products, including warranties 
of merchantability and fitness for a particular purpose, are limited to the ninety (90) day period described above. In 
no event will Ubisoft be liable for any special, incidental, or consequential damages resulting from possession, use, 
or malfunction of Ubisoft products. Some states do not allow limitations as to how long an implied warranty lasts 
and/or exclusions or limitations of incidental or consequential damages. So the above limitations and/or exclusions 
of liability may not apply to you. This warranty gives you specific rights, and you may also have other rights that 
vary from state to state.
Notice: Ubisoft reserves the right to make improvements in its products at any time and without notice.
Refunds: Ubisoft cannot provide refunds or otherwise process returns for credit of any kind other than an identical 
product replacement. Any product refund request must occur at the place of purchase, as the individual retail outlets 
set their own refund policy. This policy covers identical product replacements only.
Product/Documentation Replacements: Please contact a Ubisoft Technical Support Representative directly 
before sending your product to us. In many cases, a replacement is not the best solution. Our Support 
Representatives will help you determine if a replacement is necessary or available. You will need to first acquire an 
RMA (Return Materials Authorization) number to process your return or replacement. Without an RMA number from 
a Support Representative, your replacement request will not be processed.
If we determine a return or replacement is necessary:
Within the 90-Day Warranty Period: Please return the product (media only) along with a copy of the original 
sales receipt, showing the date of purchase, a brief description of the difficulty you are experiencing including your 
name, address (no PO boxes) and phone number to the address below. If the product was damaged through misuse or 
accident (cracks, scratches), or if you do not have a dated sales receipt, then this 90-day warranty is rendered void and 
you will need to follow the instructions for returns after the 90-day warranty period.
After the 90-Day Warranty Period: Please return the product (media only) along with a check or money 
order for the amount corresponding to your product (see replacement fees below) made payable to Ubisoft, a brief 
description of the difficulty you are experiencing, including your name, address (no PO boxes), RMA number, and 
phone number to the address below.
Replacement Fees: Our most recent replacement fee schedule is available online. Please visit 
http://support.ubi.com for an updated price list.
Warranty Address and Contact Information
Phone: 919-460-9778 
Hours: 9am–9pm (EST), M–F 
Address: Ubisoft Support • 3200 Gateway Centre Blvd. • Suite 100 • Morrisville, NC 27560
Please use a traceable delivery method when sending products to Ubisoft.
To order Ubisoft products in the United States, please call toll free 888-824-7038.

TECHNICAL SUPPORT
Before contacting Ubisoft’s Technical Support Department, please first read through this manual and the README file 
(on the game CD). Also browse through our FAQ listings or search our support database at our website, 
http://support.ubi.com. Here you will find the most recently updated information since the game’s release.
Also please make sure that your computer meets the minimum system requirements, as our support representatives 
will be unable to assist customers whose computers do not meet these criteria.
Whenever you contact the Technical Support Department, please include the following information or have it 
available if you are calling: 
• Complete product title (including version number). 
• Exact error message reported (if applicable) and a brief description of the problem you’re encountering. 
• Processor speed and manufacturer.  
• Amount of RAM.  
• Operating system. 
• Video card that you are using and amount of RAM it has. 
• Maker and speed of your CD-ROM or DVD-ROM drive. 
• Type of sound card you are using.
Support Over the Internet: This is the best way to find answers to common issues seen with our games. 
Our Frequently Asked Questions list is available 24 hours a day, 7 days a week and contains the most up-to-date 
Technical Support information available, including patches that can be downloaded free of charge. We update the 
Support pages on a daily basis, so please check here first for solutions to your problems: 
http://support.ubi.com. 
Contact Us by Webmail: Due to high volumes of spam, viruses, and other non-support-related contacts, we no 
longer offer support via standard email. However, we do provide something better, webmail. By taking your questions 
directly through our website, we have completely eliminated all spam contacts. As a result, we are able to respond to your 
questions much more quickly than we could through standard email. To send us a webmail simply log into our site at 
http://support.ubi.com. 
From this site, you will be able to enter the Ubisoft Solution Center, where you can browse through our lists of Frequently 
Asked Questions (FAQ), search our database of known problems and solutions, and send in a request for personal 
assistance from a Technical Support representative by using the Ask a Question feature on the Frequently Asked 
Questions page. Most webmail contacts are responded to within two business days. 
Contact Us by Phone: You can also contact us by phone by calling (919) 460-9778 (for our customers in 
Quebec, we provide French language support at (866) 824-6515). Please note that this number is for technical 
assistance only. No gameplay hints or tips are given over the Technical Support line. When calling our Technical 
Support line, please make sure you are in front of your computer and have all of the necessary information listed 
above at hand.
Be advised that our Technical Support representatives are available to help you Monday through Friday from 
9 am–9 pm Eastern Time (French language support available from 7 am–4 pm EST).
While we do not charge for technical support, normal long distance charges apply. To avoid long distance charges, or 
to contact a support representative directly after these hours, please feel free to browse our Frequently Asked 
Questions lists or to send us a webmail. Webmail questions usually receive a response within two business days.
Contact Us by Standard Mail: If all else fails you can write to us at:  
Ubisoft Technical Support • 3200 Gateway Centre Blvd. • Suite 100 • Morrisville, NC 27560

Return Policy: Please do not send any game returns directly to Ubisoft before contacting Technical Support. It is 
our policy that game returns must be dealt with by the retailer or online site where you purchased the product. If 
you have a damaged or scratched CD, please visit the FAQ listing for your game and get the latest replacement 
policy and pricing. We will not accept unsolicited returns/exchanges without prior approval and an RMA (Return 
Materials Authorization) number from a support representative.
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Supported OS: Windows® 98/2000/ME/XP (only)

Processor: Pentium® II 400 MHz or higher 
(Pentium III 800 MHz recommended)

RAM: 128 MB (256 MB for Windows XP)

Video Card: 4 MB DirectX® 8.1 compliant 
(16 MB DirectX 8.1 compliant recommended)

Sound Card: DirectX 8.1 compliant

DirectX Version: DirectX 8.1 (included on disc)

CD-ROM: Required

Hard Drive Space: 600 MB or more (800 MB recommended)

Other: Internet connection recommended but not required

NOTICE: This game contains technology intended to prevent copying
that may conflict with some CD-RW, DVD-RW, and virtual drives.

To install Catz®, insert the game disc into
your CD drive. If you have enabled the
Autorun option, the game installation will

start automatically. Otherwise, double-click on the CD-ROM icon in the
My Computer menu. Find setup.exe in the list of files and folders and
double-click on it to start the installation process. Follow the installa-
tion wizard guide to successfully install the game on your computer. 

To install Dogz®, just follow the same instructions. Now your Catz and
Dogz can play together!

To uninstall the game, click on the
game uninstall icon in the Start menu.

Follow the uninstallation wizard guide to
successfully uninstall the game from your computer. 

2

Installation

3

Welcome to Catz!

Catz are virtual Petz that live on your computer. Catz scamper across
your desktop, play in their home Playscenes, travel and explore far-
away Playscenes, and frolic in Playscenes that you make especially
for them. Breed them, play with them, feed them, and love them! You
can adopt as many Catz as you want – as long as you take care of
them all!

Catz are little when
you first adopt
them and grow up
over time into 
adult Catz!

Check out www.petz.com for the latest Petz info!!

And don’t forget, your Catz and Dogz can play together! 
More breedz, more Toyz, more fun! 

Whiskers for 
twitching.

Alert, expressive eyes.

Soft fur for warmth 
and petting.

Agile paws 
for jumping, 
climbing, stalking, 
and running.

Tail for 
balance.

System Requirements
What Are Catz?

Installing Petz®

Uninstalling Petz
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Catz also need regular play and 
exercise – especially if they eat too 
much. Catz can become overweight.

And, don’t forget to give them
tasty Treatz when they’ve been
good and to discourage naughty
behaviors with a squirt from the
Squirt Bottle. You can hold
Treatz above, below, or to the
sides of your Catz and give your

hand cursor a 
little wiggle. Your
cursor will give a 
little whistle and a
hand gesture if you do it right, and
your Catz will try to do a trick.
Repeated rewarding of tricks you like
will train your Catz to do them. 

Your Supply Case comes
with an initial assortment of

Toyz and supplies for your Catz to get you start-
ed. As you go to different Playscenes, you will
find more Toyz! When you place these items into
your Supply Case, you can then take them any-
where and always have as many as you want! 

You can get even more Toyz and items when you win at
the Mini Games! There are over 100 Toyz to find and win:
Balls, Treatz, and Pillows to relax on. And there are also
collectibles from your Catz’s travels – Exotic Jewels and
Carpets, Doubloons, a Flea Circus, and more.

5

Catz 5 comes with 15 breedz of Catz. Different breedz have different
personalities, but every Catz is unique! Every Catz has individual likes
and dislikes.

Left-click with your mouse and hold the
button down to pet Catz and pick up Toyz.
Right-click and hold the button down over
a Catz to pick it up and carry it. Double
left-click to call
your Catz over 
to you. Left-click
on the Pick a Pet

button on the Adoption Center to see all the
different breedz of Catz. Once you find that
special Catz, you can adopt it by clicking on
Adopt Now. Use your Supply Case to carry
Toyz and supplies. To visit Playscenes, select Go To. Click Pick to
choose which Catz to play with and take pictures of, and to view your
Catz’s Petz Profiles. Put your Catz in front of the Petz door to put them
away. Remember to only adopt as many Catz as you can care for …
neglected Catz will run away.

Catz need love and attention, 
water, food, and regular brushing.

When your Catz get sick, add Medicine to
their food or water.

4

Getting Started

Catz Care

Necessities

Fishy Treatz

Water

Food

Medicine

Squirt Bottle

Play with Your Catz
Toyz

Catnip
Scarecrow

Doll

Magic Box

Ball

C_D50024_PCS_MNL.qxd  12/14/04  5:22 PM  Page 4



With Catz 5, your Catz can frolic in their home
Playscenes – such as the Kitchen, Backyard,
Salon, and Nursery – or they can travel to the
Adventure Playscenes. Go sledding in a
Canadian Snow Scene, do tricks under the
Big Top in the European Circus Scene, play
against a Prairie Dog in the spooky Wild
West ghost town, catch Scarab Beetles in an
Arabian palace, and discover pirate treasure
on a South Seas Island. 

Each Playscene comes with its own Toyz. Some
Playscenes have more Toyz for you to discover
when you return or stay longer. 

Each of the five travel scenes has a Catz Host
with whom your Catz can play. These Hosts live
in the environment and love having guests over!

You can create your own
Playscenes for your Catz!
Select Editor on the Go To
menu and follow the step-
by-step Playscene wizard. If
you are confused, click on
the Help menu bar item and
read about the Editor in
Online Help.  

Have Fun! Create! Take 
pictures of your home and other favorite places with a digital camera
and use the BMP or JPEG for your Playscene background! Take pic-
tures and scan them into your computer – or create your own picture
using your favorite paint program!

7

Dress your Catz in stylish clothing
and accessories.

In the Salon, you will find a wardrobe full
of clothes and accessories. Left-click on an item
you want and drag it from the closet. You can
also drag the clothing on and off
your Petz, but only when you’re in
the Salon. If you put paint on your
Catz or the mice and want to
remove it, you can give them a bath!

6

Clothing & Accessories

Soapy
Sponge

Mini Games

Learn the ancient art of agility
from Monkey at the Dojo in the
Asian Temple. If you train hard
to learn his teachings, he’ll
reward you!

In the Wild West, a Prairie Dog
has moved in and he’s chal-
lenging you and your Petz to a
game of Tic-Tac-Toe! Claim your
squares by dropping your Catz
onto them when it’s your turn.

Mr. Bonez loves music and
wants your Catz to help him
compose. Get your Catz to
touch the colored tiles in the
order they light up to receive
thank you gifts from Mr. Bonez!

The Magic Book in the Fantasy
Castle loves a good game of
Rock-Paper-Scissors against
the Suit of Armor, but he needs
your help to decide among the
choices.

A silly Cobra and his horde of
Scarab Beetles have infested
Arabia! Can you and your Catz
catch them all and bring peace
to the oasis?

Can you keep your
Catz happy? When you
feed and play with Catz
regularly, take them 
to their favorite
Playscenes, and treat
them well, you’ll earn 
a Happy Pet certificate
that you can print as
proof of your fabulous
pet care talents!

Playscenes

Create Your Own Playscenes
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The Petz website at www.petz.com is a great place to visit and learn
all about Catz and Dogz. This is where you’ll find out about awesome
new Petz products, accessories, and the latest news. And, with the
Petz Player (automatically installed with Catz 5 and Dogz 5), you can
play with your Petz and other owners' Petz on fan websites!

Check www.petz.com often for all the latest information on Petz!

The Petz Publisher wizard walks you
through creating your own web page.

Choose from many templates, some of which
let you share a “live” version of your Catz online with others! See the

Petz Player section below for more information.

The Petz Web Fun Pack is chock-full of
Petz clip art, animations, backgrounds,
and more!

With the Petz Player you can play with 
your Catz and other Catz online. Catz 5

automatically installs the Petz Player on your computer. Go to
www.petz.com to play with some Petz online, or you can create your
own web page using the Live templates in the Petz Publisher.

In the General Options menu, you can adjust the
frequency of the Night Cycle. Setting it faster
than real-time does not mean your Kittenz will
grow faster.

Each day you run the Petz program, your
Petz will grow a bit (until it reaches full

size). However, if you leave your program
running overnight, this will not automatically happen. You must

restart the game each day. Kittenz become Adult Catz in approxi-
mately three to four days. Catz do not get old or die. When your Catz
have a litter, Newborns become Infants in two to three days.
Newborns become Kittenz in seven days.

9

Now you can customize the look of your Carrying Case! Inside your
Petz folder on your hard drive is the Skinz folder. Within is a template
that you can modify with the paint program of your choice. 

Simply keep your art for the buttons restricted to the sizes in the
template and everything positioned on the template where you found
it. Petz will need your Skinz files to be 24-bit BMP files. (More
detailed information is available in the Skinz Instructions document
included in the Skinz folder.)

You can create new art for all
three states of the Carrying
Case as well as for the buttons.
However, you cannot change the
art of the red door that your
Catz come in and out of.

You can change between vari-
ous Skinz using the File menu. 

Your Catz can have Kittenz!
You need to have a female
Catz and a male Catz who are
in love. You’ll know your Catz
are in love when they groom
each other, follow each other
around, and bring
each other Toyz and
Treatz. You can set

the mood and help Catz fall in love with special
Aphrodisiacs such as the Heart Pillow, the Perfume, the Love
Potion, the Music Box, and the Heart Candy.  Go to the Petz

Profile by clicking on the pink or blue
Catz icon on the Carrying Case. Here you can

view the statistics of your Catz and see up to
eight generations of your Catz’s Family Tree.

8

Create Your Own Carrying Case

Perfume

Music Box

Petz Profile

Petz Publisher

Petz Player

Petz Web 
Fun Pack

www.petz.com

Carousel

How Petz Grow

Day & Night
Cycles

Tips!

Catz Families
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Dogz are virtual Petz that live on your computer. Dogz scamper
across your desktop, play in their home Playscenes, travel and explore
faraway Playscenes, and frolic in Playscenes that you make especially
for them. Breed them, play with them, feed them, and love them! You
can adopt as many Dogz as you want – as long as you take care of
them all!

Dogz are little 
when you first 
adopt them and grow
up over time into
adult Dogz!

11

Careful! When you cheat with your computer’s
calendar to speed up the birth of your Kittenz,
the mother will become stuck in her pregnancy

status. If this happens, there is no way to fix it! Be patient – don’t 
do it!

You can bring all the Toyz and objects you find in Catz 5
with you everywhere you go!  When you find a new Toyz

or win one in a Mini Game, simply drag it to the
Toyz Shelves to keep it with you anywhere you go.  

If you have Catz on your com-
puter from earlier versions, you
can import them into Catz 5

through the File menu. 

If any of your Catz run away, they may 
be found and turned in to the Adoption
Center! Check the Message Board next 

to the building for any notes that your Catz was found. If
your Catz runs away, you will only get one more chance to
be a good Catz owner. Your Catz depend on you for their 
care and happiness!  

Some fans modify the files in the game and offer
them for downloading on their fan sites. We think this

is cool! In fact, we’re flattered. But since Ubisoft did not
create this content, installing any modified files not from Ubisoft
breaches our warranty and support policies. In other words, if it
breaks the game, we cannot help you fix it.

10

Toyz

Importing Petz

Runaways

Hexies

Unicorn
Plush Toy

Spider
Cookie Treatz

Welcome to Dogz!

Dogz have
a keen
sense of
smell.

Alert, expressive eyes. Dogz love to
be petted.

Dogz have fuzzy 
padded paws for 
running, digging, 
and scratching.

Tail for 
balance.

Pregnancies What Are Dogz?
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Don’t forget to give them tasty Treatz when they’ve been good
and to discourage naughty behaviors with a squirt
from the Squirt Bottle. You
can hold Treatz above,
below, or to the sides of
your Dogz and give your
hand cursor a little wiggle.
Your cursor will give a little
whistle and a hand gesture if
you do it right, and your Dogz
will try to do a trick. Repeated
rewarding of tricks you like will
train your Dogz 
to do them.

Your Supply Case comes with an initial
assortment of Toyz and supplies for your Dogz

to get you started. As you go to different Playscenes, you
will find more Toyz! When you place these items into your
Supply Case, you can then take them anywhere and always
have as many as you want! 

You can get even more Toyz and items when
you win at the Mini Games! There are over 100
Toyz to find and win: Balls, Bonez, Chew Toyz,
and Pillows to relax on. And there are also 
collectibles from your Dogz’s travels – Exotic
Jewels and Carpets, Doubloons, a Flea Circus,
and more.

Dogz 5 comes with 15 breedz of Dogz. Different breedz have different
personalities, but every Dogz is unique! Every Dogz has individual likes
and dislikes.

Left-click with your mouse and hold the 
button down to pet Dogz and pick up Toyz.
Right-click and hold the button down over 
a Dogz to pick it up and carry it. Double 
left-click to call your Dogz over to you.

Left-click on the
Pick a Pet button on

the Adoption Center to see all the different
breedz of Dogz. Once you find that special
Dogz, you can adopt it by clicking on Adopt
Now. Use your Supply Case to carry Toyz
and supplies. To visit Playscenes, select Go To. Click Pick to choose
which Dogz to play with and take pictures of, and to view your Dogz’s
Petz Profiles. Put your Petz in front of the Petz door to put them
away. Remember to only adopt as many Dogz as you can care for …
neglected Dogz will run away.

Dogz need love and attention, water, food, and
regular brushing. When your Dogz get sick,

add Medicine to their food or water.

Dogz also need regular play
and exercise – especially if
they eat too much. Dogz can 
become overweight.

Getting Started

Necessities

WaterMedicine Food

Dogz Care

Squirt
Bottle

Beefy
Treatz

Toyz

Car

Scarecrow
Doll

Magic Box

Play with Your Dogz

Ball
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With Dogz 5, your Dogz can frolic in their
home Playscenes – such as the Kitchen,
Backyard, Salon, and Nursery – or they can
travel to the Adventure Playscenes. Go 
sledding in a Canadian Snow Scene, do tricks
under the Big Top in the European
Circus Scene, play against a Prairie
Dog in the spooky Wild West ghost
town, catch Scarab Beetles in an
Arabian palace, and discover pirate 
treasure on a South Seas Island.

Each Playscene comes with its own
Toyz. Some Playscenes have more Toyz 
for you to discover when you return or 
stay longer. 

Each of the five travel scenes has a Dogz
Host with whom your Dogz can play. These
Hosts live in the environment and love having guests over!

You can create your own
Playscenes for your Dogz!
Select Editor from the Go To
menu and follow the step-by-
step Playscene wizard. If you
are confused, click on the
Help menu bar item and 
read about the Editor in
Online Help.

Have Fun! Create! Take pictures of your home and other favorite
places with a digital camera and use the BMP or JPEG for your
Playscene background! Take pictures and scan them into your com-
puter – or create your own picture using your favorite paint program!

1514

Dress your Dogz in stylish clothing
and accessories.

In the Salon, you will find a wardrobe
full of clothes and accessories. Left-
click on an item you want and drag it
from the closet. You can also drag
the clothing on and off your Petz, but only when
you’re in the Salon. If you put paint on your Dogz
or the mice and want to remove it, you can give
them a bath!

Learn the ancient art of agility
from Monkey at the Dojo in the
Asian Temple. If you train hard
to learn his teachings, he’ll
reward you!

In the Wild West, a Prairie Dog
has moved in and he’s chal-
lenging you and your Petz to a
game of Tic-Tac-Toe! Claim your
squares by dropping your Dogz
onto them when it’s your turn.

Mr. Bonez loves music and
wants your Dogz to help him
compose. Get your Dogz to
touch the colored tiles in the
order they light up to receive
thank you gifts from Mr. Bonez!

The Magic Book in the Fantasy
Castle loves a good game of
Rock-Paper-Scissors against
the Suit of Armor, but he 
needs your help to decide
among the choices.

A silly Cobra and his horde of
Scarab Beetles have infested
Arabia! Can you and your Dogz
catch them all and bring peace
to the oasis?

Can you keep your
Dogz happy? When
you feed and play with
Dogz regularly, take
them to their favorite
Playscenes, and treat
them well, you’ll earn 
a Happy Pet certificate
that you can print as
proof of your fabulous
pet care talents!

Soapy
Sponge

Clothing & Accessories

Mini Games

Playscenes

Create Your Own Playscenes
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Now you can customize the look of your Carrying Case! Inside your
Petz folder on your hard drive is the Skinz folder. Within is a template
that you can modify with the paint program of your choice. 

Simply keep your art for the buttons restricted to the sizes in the
template and everything positioned on the template where you found
it. Petz will need your Skinz files to be 24-bit BMP files. (More
detailed information is available in the Skinz Instructions document
included in the Skinz folder.)

You can create new art for all three
states of the Carrying Case as well
as for the buttons. However, you
cannot change the art of the red
door that your Dogz come in and
out of.

You can change between various
Skinz using the File menu. 

Your Dogz can have Puppyz! You
need to have a female Dogz and
a male Dogz who are
in love. You’ll know
your Dogz are in love
when they groom
each other, follow
each other around,

and bring each other Toyz and Treatz. You can set the mood and
help Dogz fall in love with special items such as the Heart Pillow,

the Perfume, the Love Potion, the Music Box, and the Heart Candy.
Go to the Petz Profile by clicking on the pink or

blue Dogz icon on the Carrying Case. Here you can
view the statistics of your Dogz and see up to eight

generations of your Dogz’s Family Tree.

16 17

The Petz website at www.petz.com is a great place to visit and learn
all about Catz and Dogz. This is where you’ll find out about awesome
new Petz products, accessories, and the latest news. And, with the
Petz Player (automatically installed with Catz 5 and Dogz 5), you can
play with your Petz and other owners' Petz on fan websites!

Check www.petz.com often for all the latest information on the Petz!

The Petz Publisher wizard walks you
through creating your own web page.

Choose from many templates, some of
which let you share a “live” version of your Dogz online with

others! See the Petz Player section below for more information.

The Petz Web Fun Pack is chock-full of
Petz clip art, animations, backgrounds,
and more!

With the Petz Player you can play with your
Dogz and other Dogz online. Dogz 5 
automatically installs the Petz Player on

your computer. Go to www.petz.com to play with some Petz online, or
you can create your own web page using the Live templates in the
Petz Publisher.

In the General Options menu, you
can adjust the frequency of the
Night Cycle. Setting it faster than
real-time does not mean your

Puppyz will grow faster. 

Each day you run the Petz program,
your Petz will grow a bit (until it reaches full

size). However, if you leave your program running overnight, this
will not automatically happen. You must restart the game each day. 

Dogz Families

Petz Profile

Music Box

Perfume

Create Your Own Carrying Case www.petz.com

Petz Publisher

Petz Player

Petz Web 

Fun Pack
Carousel

Day & Night
Cycles

Bacon Treatz

How Petz Grow

Tips!
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Ubisoft and the Ubisoft logo are trademarks of Ubisoft Entertainment
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Puppyz become Adult Dogz in approximately three to four days. 
Dogz do not get old or die. When your Dogz have a litter, Newborns 
become Infants in two to three days. Newborns become Puppyz in
seven days.

Careful! When you cheat with your computer’s
calendar to speed up the birth of your Puppyz,
the mother will become stuck in her pregnancy

status. If this happens, there is no way to fix it! Be patient – don’t 
do it!

You can bring all the Toyz and objects you find in Dogz 5
with you everywhere you go! When you find a new Toyz
or win one in a Mini Game, simply drag it to the Toyz

Shelves to keep it with you anywhere you go. 

If you have Dogz on your computer from 
earlier versions, you can
import them into Dogz 5

through the File menu. 

If any of your Dogz run away, they
may be found and turned in to the
Adoption Center! Check the Message

Board next to the building for any notes saying that your
Dogz was found. If your Dogz runs away, you will only get
one more chance to be a good Dogz owner. Your Dogz
depend on you for their care and happiness! 

Some fans modify the files in the game and offer
them for downloading on their fan sites. We think this

is cool! In fact, we’re flattered. But since Ubisoft did not
create this content, installing any modified files not from Ubisoft
breaches our warranty and support policies. In other words, if it breaks
the game, we cannot help you fix it.

Pregnancies

Toyz

Importing Petz

Runaways

Hexies

Unicorn
Plush Toy

Spider
Cookie Treatz
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Address: Ubisoft Support • 3200 Gateway Centre Blvd. • Suite 100 • Morrisville, NC 27560
Please use a traceable delivery method when sending products to Ubisoft.
To order Ubisoft products in the United States, please call toll free 888-824-7038.

TECHNICAL SUPPORT
Before contacting Ubisoft’s Technical Support Department, please first read through this manual and the README file 
(on the game CD). Also browse through our FAQ listings or search our support database at our website, 
http://support.ubi.com. Here you will find the most recently updated information since the game’s release.
Also please make sure that your computer meets the minimum system requirements, as our support representatives 
will be unable to assist customers whose computers do not meet these criteria.
Whenever you contact the Technical Support Department, please include the following information or have it 
available if you are calling: 
• Complete product title (including version number). 
• Exact error message reported (if applicable) and a brief description of the problem you’re encountering. 
• Processor speed and manufacturer.  
• Amount of RAM.  
• Operating system. 
• Video card that you are using and amount of RAM it has. 
• Maker and speed of your CD-ROM or DVD-ROM drive. 
• Type of sound card you are using.
Support Over the Internet: This is the best way to find answers to common issues seen with our games. 
Our Frequently Asked Questions list is available 24 hours a day, 7 days a week and contains the most up-to-date 
Technical Support information available, including patches that can be downloaded free of charge. We update the 
Support pages on a daily basis, so please check here first for solutions to your problems: 
http://support.ubi.com. 
Contact Us by Webmail: Due to high volumes of spam, viruses, and other non-support-related contacts, we no 
longer offer support via standard email. However, we do provide something better, webmail. By taking your questions 
directly through our website, we have completely eliminated all spam contacts. As a result, we are able to respond to your 
questions much more quickly than we could through standard email. To send us a webmail simply log into our site at 
http://support.ubi.com. 
From this site, you will be able to enter the Ubisoft Solution Center, where you can browse through our lists of Frequently 
Asked Questions (FAQ), search our database of known problems and solutions, and send in a request for personal 
assistance from a Technical Support representative by using the Ask a Question feature on the Frequently Asked 
Questions page. Most webmail contacts are responded to within two business days. 
Contact Us by Phone: You can also contact us by phone by calling (919) 460-9778 (for our customers in 
Quebec, we provide French language support at (866) 824-6515). Please note that this number is for technical 
assistance only. No gameplay hints or tips are given over the Technical Support line. When calling our Technical 
Support line, please make sure you are in front of your computer and have all of the necessary information listed 
above at hand.
Be advised that our Technical Support representatives are available to help you Monday through Friday from 
9 am–9 pm Eastern Time (French language support available from 7 am–4 pm EST).
While we do not charge for technical support, normal long distance charges apply. To avoid long distance charges, or 
to contact a support representative directly after these hours, please feel free to browse our Frequently Asked 
Questions lists or to send us a webmail. Webmail questions usually receive a response within two business days.
Contact Us by Standard Mail: If all else fails you can write to us at:  
Ubisoft Technical Support • 3200 Gateway Centre Blvd. • Suite 100 • Morrisville, NC 27560

Return Policy: Please do not send any game returns directly to Ubisoft before contacting Technical Support. It is 
our policy that game returns must be dealt with by the retailer or online site where you purchased the product. If 
you have a damaged or scratched CD, please visit the FAQ listing for your game and get the latest replacement 
policy and pricing. We will not accept unsolicited returns/exchanges without prior approval and an RMA (Return 
Materials Authorization) number from a support representative.

Note: This file should be common to all PC Manuals without a perfect bound spine–
any changes other than the file name must be updated on the template.
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FREE
 2-DAY SHIPPING!*

Buy online and avoid the lines with FREE 2-day shipping 
from the Ubisoft Store. Enter 2DAYFREE at checkout! Spend 
your time playing this game, while we deliver the next one, 
shipped FREE!
*To redeem this coupon, go to http://store.ubi.com and enter Coupon Code 2DAYFREE at checkout. Offer 
expires July 31, 2005. Offer applies to your next purchase at the Ubisoft Store. Products subject to 
availability. May not be combined with any other promotional offers or discounts, applied to previous orders, 
substituted, exchanged, sold, or redeemed for cash or other goods or services. Limit one per customer. 
Offer valid on orders with U.S. shipping destinations only. Offer only available at http://store.ubi.com.

682295-MNLUbisoft, Inc. · 625 Third Street · Third Floor · San Francisco, CA 94107
© 2004 Ubisoft Entertainment. All Rights Reserved. Portions of Chessmaster Academy 
instructional content © 2004 Joshua Waitzkin. Chessmaster is a registered trademark and 
Ubisoft, ubi.com, and the Ubisoft logo are trademarks of Ubisoft Entertainment in the U.S. 
and/or other countries. Software platform legal TM and © IEMA 2003.

Made in the U.S.A.

AVAILABLE NOW
Master History's Greatest Game

Learn to avoid costly mistakes 
with specific advice in Blunder 
Alert mode.

Powerful enough to take your 
game to the Grandmaster level. 

Easy-to-navigate interface with  
a huge variety of 3D sets and 
boards.

Receive personalized instruction  
at the Chessmaster Academy.

Use enclosed glasses for an  
enhanced 3D view.

www.chessmaster.com
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